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Preface

Description

The Tempo Communications fiberTOOLS™ 930XC instruments are handheld Optical Time Domain Reflectometers (OTDRs) for
measuring the specifications of single-mode or multi-mode optical fiber.

+ The 930XC-20C measures optical fiber at 1310 nm and 1550 nm.

+ The 930XC-20M measures optical fiber at 850 nm and 1300 nm.

+ The 930XC-30F measures optical fiber at 1310 nm, 1550 nm, and 1625 nm.

+ The 930XC-30P measures optical fiber at 1310 nm, 1490 nm, and 1550 nm.
Included with the 930XC instruments are the following:

+ USB and serial data transfer cables

« Power adapter

+ Vehicle adapter power cord

+ Trace Viewer software installation disk

+ Instruction manual

+ Soft carrying case

Safety

Safety is essential in the use and maintenance of Tempo Communications tools and equipment.
This instruction manual and any markings on the tool provide information for avoiding hazards and unsafe practices related to
the use of this tool. Observe all of the safety information provided.

Purpose of This Manual

This instruction manual is intended to familiarize all personnel with the safe operation and maintenance procedures for the
Tempo Communications 930XC handheld OTDRs.

Keep this manual available to all personnel. Replacement manuals are available upon request at no charge.

Warranty

Tempo Communications Inc. warrants to the original purchaser of these goods for use that these products will be free from
defects in workmanship and material for one year. This warranty is subject to the same terms and conditions contained in
Tempo Communication’s standard one-year limited warranty.

For all Test Instrument repairs, contact Customer Service at 800-642-2155 to request a Return Authorization.

For items not covered under warranty (such as items dropped, abused, etc.), a repair cost quote is available upon request.
Note: Prior to returning any test instrument, please check replaceable batteries or make sure the battery is at full charge.

All specifications are nominal and may change as design improvements occur.
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Important Safety Information

SAFETY
ALERT
SYMBOL

This symbol is used to call your attention to hazards or unsafe practices which could result in an
injury or property damage. The signal word, defined below, indicates the severity of the hazard.
The message after the signal word provides information for preventing or avoiding the hazard.

ADANGER

Immediate hazards which, if not avoided, WILL result in severe injury or death.

AWARNING

Hazards which, if not avoided, COULD result in severe injury or death.

ACAUTION

Hazards or unsafe practices which, if not avoided, MAY result in injury or property damage.

AWARNING

Read and understand all of the instructions and safety information in this
manual before operating or servicing this tool.

Failure to observe this warning could result in severe injury or death.

AWARNING

Electric shock hazard:

Do not operate in an explosive atmosphere such as in the presence of flammable gases or
fumes.

Before applying power, verify that the unit is set to match the available line voltage.

Failure to observe these warnings could result in severe injury or death.
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Important Safety Information (cont'd)

AWARNING

Electric shock hazard:
Fuse replacement should be performed by Tempo qualified personnel.
Do not use repaired fuses or short-circuited fuse holders.

Failure to observe these warnings could result in severe injury or death.

The 930XC instruments are laser devices
conforming to the requirements of CDRH,
C A U T I O N CFR 1040, Subchapter J. While there is no
potential for eye damage due to unaided
LASER LIGHT :jirekgt exp.osu:e,.userf] should always ?]void
DO NOT STARE INTO BEAM ooking d|r_ect y into the output port. The
use of optical viewing instruments, such
as microscopes, magnifiers, etc., should
CLASS 1 LASER PRODUCT | always be avoided. The use of such devices
around active fibers can focus an intense
beam of light energy onto the retina of
the eye, which can result in permanent
damage.

ACAUTION

Laser hazard:

When performing measurements on fiber optic systems, avoid eye exposure to any open-
ended fibers, optical connectors, optical interfaces, or other sources because they may be
connected to active laser transmitters.

Do not look into the optical port when a source is turned on.

Avoid looking at the free end of a test fiber, i.e., the end not connected to the instrument. If
possible, direct the free end toward a non-reflective surface.

Failure to observe these precautions may result in injury.
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Important Safety Information (cont'd)

ACAUTION

Electric shock hazard:

Do not expose batteries to fire or intense heat. Do not open or mutilate batteries. Avoid
touching the electrolyte in the batteries, which is corrosive and may cause damage to eyes or
skin.

Do not open the case of the unit for any reason. It contains no user-serviceable parts.

Use this unit for the manufacturer's intended purpose only, as described in this manual. Any
other use can impair the protection provided by the unit.

Failure to observe these precautions may result in injury and may damage the unit.

ACAUTION

Instrument damage hazard:

+ Make sure that the optical fiber or cable is not in use and there is no laser beam in the fiber
before testing with this unit.

+ Do not leave the unit in direct sunlight or near direct sources of heat.
+ Protect the unit from strong impacts or shock.
+ Do not immerse the unit in water or store in areas with high humidity.

+ When necessary, clean the case, front panel, and rubber cover with a damp cloth. Do not use
abrasives, harsh chemicals, or solvents.

+ Replace the protective dust cap when the unit is not in use.
+ Store the unit and interface adapters in a cool, dry, and clean place.

Failure to observe these precautions may result in injury and may damage the unit.

ACAUTION

Electric shock hazard:
+ Do not expose the unit to extremes in temperature or high humidity. Refer to “Specifications.”

+Turn the unit off, disconnect from power, and make sure the laser source is off before
cleaning.

Failure to observe these precautions may result in injury and may damage the unit.
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Section 1. Introduction

Tempo's 930XC handheld OTDRs can make an assessment of one single optical fiber or a whole optical fiber chain. In addition,
the user can directly observe loss and events distribution of an optical fiber chain.
The 930XC tools check the transmission quality of optical fiber through the measurement of backscatter. Standard
organizations like the International Telecom Union (ITU) define backscatter as an effective analysis means to measure optical
fiber loss. Backscattering is also the only effective way of connector inspection, which can be applied to measure the length of
optical fiber.
The 930XC OTDRs operate by reviewing events in optical fiber (for example, irregularities and connectors). These tools can
help identify irregularities in optical fiber, locate them, and measure their attenuation, relevant loss, and homogeneity.
These tools are easy-to-use, small, and compact with large LCD displays and graphical interfaces. They can save and transfer
the measurement curves data to a PC by using the provided Trace Viewer software for further analyzing, reporting, and
printing.
Basic applications:

+ Measure the length of optical fiber and cable.

+ Measure the distance between two points on optical fiber and cable.

+ Locate faults and ruptures of optical fiber and cable.

+ Display distribution curve of optical fiber and cable loss.

+ Measure attenuation coefficient of optical fiber and cable.

+ Measure loss between two points on optical fiber and cable.

+ Measure loss of tie-ins.

+ Measure reflection of reflection events of optical fiber and cable.

+ The 930XC-30F can measure live optical fibers at 1625 nm.

For a specific event (transmission quality changed due to faults caused by fusion splicing, connector, bending, etc.), the
following measurements can be carried out:

+ For each event: Distance, loss, and reflection.

+ For each section of optical fiber: Length and loss of dB or dB/unit length.

+ For the whole optical fiber chain: Length and loss of dB.

Additional features:
+ Large LCD display with auto or manual adjustment of contrast.
+ Backlight LCD display supports night operation.
+ Easy operation with trace graphic display.
+ Trace storage function.
+ RS-232 and USB data upload ports.
+ Trace Viewer software for analyzing and reporting previously stored data.
+ Auto off function to conserve battery life.
+ DC/AC power supply.
+ Macrobend analysis.
+ Link Viewer for automated Pass/Fail analysis.
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Section 2. Basic Operation

This section describes the basic operation of the 930XC instruments. Specific operations are explained in detail in Section 3 of
this manual.

Instrument Interface Description

CEad—™

Figure 2-1. Interface Panel
Charge Indicator: When lit, measurement power is charging.
Power Indicator: When lit, measurement power is on.

AC Power Jack: Power adapter jack requirements are 13.8 VDC at 1.2 A.

Ll .

Data Transfer Ports: USB and RS-232 interfaces to transfer saved traces in the instrument to a PC for further analysis
with Trace Viewer software (provided).

5. Fiber Optic Output for OTDR or 1625 nm live fiber, and VFL (visual fault locator): Connector is used for
the OTDR interface.

6. Invisible Laser Caution: Do not look directly at the optical output or stare at the laser beam.
7. OPM Optical Power Meter

Use of Batteries
The 930XC tools use a NiMH battery.

Auto Off Mode

* The instrument will enter auto off mode when there is insufficient power during operation. The low power icon will be
displayed on the LCD.
If unused for a long time, causing insufficient power, the instrument will enter auto off mode several seconds after
powering on in order to protect the batteries in case of excessive discharging. The internal battery should be recharged
immediately through the adapter.

Recharging

* Perform a quick charge first, and then switch to trickle charge after the voltage reaches a predefined figure. Quick charge
temperature is 5 °C to 45 °C (41 °F to 113 °F), and trickle charge temperature is 0 °F to 55 °C (32 °F to 131 °F). Battery
will not be fully charged or may be damaged if the charging temperature is beyond the above range, which may shorten
battery life.

A quick charge takes 3 hours.
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— §F TEMPO —

COMMUNICATIONS

Figure 2-2. 930XC Keypad

1. On/Off: Press to turn power on or off to the instrument.

2. Run/Stop:

Under GUI, press to start measurement.
While testing, press to stop measurement.

3. Enter:

Under GUI, press to confirm the current operation.
Use with the Shift key to zoom out trace vertically.

4. AV (up and down) arrows:

Move menu bar in menu operation.

Highlight the icon to be selected.

Adjust parameter in parameter configuration.

Use q with the Shift key to browse up the events list.
Use p with the Shift key to zoom in trace vertically.

5. <> (left and right) arrows:

Select parameter to be adjusted in parameter configuration.
Move marker left or right in trace operation.

Turn pa ge while in Help submenu.

Use with the Shift key to zoom out or zoom in trace horizontally.

6. K" arrow:

Read Help menu when power on.

Cancel the current operation.
Exit menu configuration.

Switch between information windows.

7. Shift:

Use with the Shift key to browse down the events list.

Under GUI, press to return a trace to original size without any zoom.
Activate the integration function by pressing this key together with other keys.
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Section 3. Basic OTDR Information
Principle of OTDRs

An OTDR (Optical Time Domain Reflectometer) is a measurement instrument for identifying optical fiber transmission features.
The OTDR is used to measure the overall attenuation of a fiber optic link and to provide details relating to the position of

each event in that link. Events include splices, connectors, bends, and optical components. Its non-destructive, single-

ended connection and rapid measurement have made the OTDR an indispensable tool for manufacturing, construction, and
maintenance of optical fiber links.

The faults and heterogeneity of optical fiber itself cause Rayleigh scattering of light transmitted in optical fiber. Part of the light
pulse is scattered in the reverse direction, and this is called Rayleigh backscattering, which actually provides attenuation details
relating to fiber length.

Information relating to distance is obtained through time information (thus “time domain” in the name OTDR). Fresnel reflection
occurs at the boundary between two media of different IOR (for example, connections of faults, connectors, or optical fiber end).
This reflection is used to locate the discontinuous points on optical fiber. The magnitude of reflection depends on the difference
between I0OR and the smoothness of boundary.

An OTDR sends out a light pulse into the optical fiber and receives reflections of events and backscattering power of the pulse in
time. Locations will be displayed on the LCD. The y-axis is the dB value of backscattering power, and the x-axis is the distance.

Basic Definition and Classification of Events

Events refer to any abnormal points causing attenuation or sudden change of scattering power besides the normal scattering of
optical fiber, which include losses such as bending, connections, and ruptures.

Event points displayed on the LCD are abnormal points that cause traces to deviate from a straight line.

Events can be classified as reflection events or non-reflection events.

Reflection Events
When some pulse energy is scattered, reflection events occur. When reflection events occur, a peak is displayed on the trace

R e —— -

(Figure 3-1).
Non-reflection Events
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Figure 3-2. Non reflection Event
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When some pulse energy is scattered, reflection events occur. When reflection events occur, a peak is displayed on the trace
(Figure 3-1).

Measurement Application

The 930XC instruments display power relating to the distance of returning signals. This information can be used to identify the
main properties of an optical fiber chain.

Measurement Contents
+ Event location (distance), end, or rupture of optical fiber chain.
+ Attenuation coefficient of fiber.
+ Loss of a single event (for example, one optic tie-in), or total loss from upper end to end.
+ Range of a single event like reflection of connectors (or grade of reflection).
+ Auto measurement of cumulative loss of a single event.

Trace Analysis
The trace analysis of the 930XC OTDR is fully automatic. The trace locates:
+ Reflection events of connections and mechanical tie-ins.
+ Non-reflection events.
+ End of optical fiber.
+ Through scanning the first loss event that is larger than the end threshold, identifies the end of optical fiber.
+ Events list: Event type, loss, reflection, and distance.
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8Km/Div 5.00dB/Div tracel Event 3

No.: 2/4 A Location; 25.308km A
Refl.:-38.12dB Ins.l: 0.85dB

Attn.:10.22dB/km Cum.l: 5.57dB i

Figure 3-3. Trace Display Screen

Trace Display Screen

The trace displays on the 930XC screen (Figure 3-3).
Trace Display Window

This window displays the trace after one measurement.

Definition of trace: After one measurement, the reflection power diagram will be displayed as a distance function. This diagram
is referred to as trace.

Relative Power

Distance

— >

Figure 3-4. Traces and Coordinates
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The trace of the 930XC displays measurement results in a graphic form. The y-axis represents the power while the x-axis
represents the distance (Figure 3-4).

Information Window
The contents of this window are measurement parameters, events list, marker A/B, and analysis parameters.

B 1628

8Km/Div 5.00dB/Div 8Km/Div 5.00dB/Div tracel Para-2

ERELLE E:E::mﬁmﬁ

WEITEEE o)

tracel Para-1
Avg.Time: 30s Samp.Dist.: 5.11m Date: 27-May-2019 09:15
Range: 80km PulseWidth: 2.5us NRefl.Thre.: 0.20 End Thre.: 3.00
)R 1.4659 Wavelength: 1550nm Refl.Thre.: .52.00 Scat.Coef.: .51.50
Figure 3-5a. Measurement Trace Parameters Figure 3-5b. Analysis Trace Parameters

Measurement Trace Parameters

Important measurement and analysis parameters are displayed in the information window (Figures 3-5a and 3-5b).

For definitions and configurations of items in Figure 3-5a (average time, sample distance, range, IOR, wavelength, and pulse
width) as well as definitions of items in Figure 3-5b (date, reflection threshold, non-reflection threshold, end threshold, and
scattering coefficient), refer to “Parameter Configuration” in this section of the manual.

Events List

Attn.: 0.22dB/km Cum.L.: 5.57dB

L=

ﬂ,:

; | a3

8Km/Div 5.00dB/Div tracel Event I

No.: 2/4 JU Location: 25.308km My
Refl.:-38.12dB Ins.L.: 0.85dB

I

Figure 3-6. Events List

The events list indicates the location of events inspected. Any defined posts will be displayed in the events list (for example, a
non-reflection event such as a fusion splice or a reflection event such as a connector) (Figure 3-6).

+ No.: Event sequence number.

+ Four types of events: begin end; reflection event; fiber end; attentuation event.
+ Location: Distance from beginning point to event.

+ Refl.: Magnitude of reflection.

+ Ins.L.: Loss of inserted event.
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+ Attn.: Attenuation characteristic from one event point to the current event.
« Cum.L.: Cumulative loss, calculating from beginning point to the current event.

1
n:
fKm/Div 5.00dB/Div tracel Marker 1
A-B: 9.274km %
2Pt.Loss : 1.71dB
2Pt.Atten:  0.18dB/km i

Figure 3-7. Marker A/B Information

Marker A/B Information
A marker is used to mark and analyze a single event, trace section, and distance. Distance, attenuation, and loss at a marker or
between markers will be displayed in marker information (Figure 3-7).

The following parameters are measured between marker A and B. Changing either marker will change the record accordingly.
+ A-B: Distance between two markers.

+ 2Pt. Loss: Loss between two markers; power difference between two markers.
+ 2Pt. Atten: 2 points loss of unit length.

The specific operations of the above items are explained in more detail later in this manual.

mﬂm?ﬂ-

=]

=

[

%

4

RKm/Div 5.00dB/Div tracel Fiber I

File: tracel Ay
Total Atitn.: 0.24dB/km

Length: 62.180km Loss: 14.92dB |{ll

Figure 3-8. Fiber Information
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Fiber Information
Fiber information includes total attenuation, length, and loss of the tested fiber (Figure 3-8).

No. Icons Description
1 Vi Parameter configuration

2 = Save file

3 = Open file

4 =l Re-analyze the trace

5 7k Zoom out trace horizontally
6 " Zoom in trace horizontally
7 nx Zoom out trace vertically

8 $ Zoom in trace vertically

9 Ag Switch between markers
10 T Review events list upward
11 3 Review events list downward
12 (LI Battery power indicator

Menu Bar and Icons
Notes:
+ Under the Help menu, only numbers 1 and 3 are operational.
+ In the process of measurement, all functions on the menu bar will be disabled.
« Numbers 3,4, 5, 6,7, 8, and 9 are tools for trace analysis. Numbers 10 and 11 are tools for reviewing events list.
+ Number 1 is explained in the next section, “Parameter Configuration.”

Parameter Configuration

Correct parameter configuration is necessary for accurate measurements.
Use A and ¥ to highlight /2 (i.e., parameter configuration on the menu bar), and then press Enter (Figure 3-9).
Press K to exit.

[ . =
2
[Range N0 .? Scat.Coef. -82.0dB .g
| | PulseWidth Auto S [NRefl.Thre. 0%0&&8 E]
" | Avg. Time 30s - 1R efil=Thire -52. :
Wavelength 1550 nm % F)"“j I'h rl'e'll 3.00dB _ﬂ

] g 1 Delete File
Meas. Mode Averaging > Time(y-m-d) 2005-05-27 10:30:20 +
PM/LS i i N
: « Auto Off Off €
Length Units i\/IztgérG (m] [ Language English [
Is(szt Coef —5.2 1dB [b4 LCD Contrast i
| ¢ | Nrefl Thre. 0.20 dB : 5 f?i‘&r.f’l?.f'eh Color 2 t
A | Refl. Thre. -52.00dB o=t EAL v
R | End Thre. 3.00 dB 8 R B
UK :  1.4000 waveiengul : 15ou nm il IOk @ 1.40// wavelengin: 13dunm | (i

Figure 3-9. Parameter Configuration
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Definitions of Measurement Parameters

Range

Length of optical fiber relevant to the trace

Pulse Width

Width of laser pulse sent out from OTDR to optical fiber

Average Time

Select suitable testing time

Wavelength

Select laser wavelength for measurement

Measurement Mode

Select mode for measurement

PM/LS

Optical power meter, stabilized laser source, and VFL

Length Units

Select units of measurement

IOR

IOR of optical fiber which affects the transmission speed of laser

Scatter Coefficient

Affects backscatter power of laser in fiber

Non-reflection

Events whose insertion loss is > the threshold displayed here

Threshold

Reflection Threshold Reflection events > the threshold displayed here

End Threshold First event with insertion loss > the threshold is considered the end of
fiber, and all following events will be ignored

Delete File Delete stored trace data in the instrument

Time Show current system time

Auto Off Enable or disable auto off function

Lang./ i & Choose language

LCD Contrast Adjust contrast of LCD

Color Mode Select suitable color setting for display

Load Default Set all parameters to factory setting

Help Show Help files (quick reference)

Range Configuration

Generally, the range is set according to the actual length of optical fiber in order to insure the accuracy of the measurement.
Under the parameter configuration menu use A and ¥ to highlight “Range.” Press Enter to select a range (Figure 3-10).

Press to K7 exit.
: wmm : : :
2
J
k PulseWidth 300 m g
Avg. Time 1.3km -
Wavelength 2 5km E
Meas. Mode Skm >
PM/LS 10 km T
Length Units 20 km 1
+
o b ;
cat. Coef.
| 80 knr
¢ | Nrefl . Thre. 160 k:n :
A | Refl.Thre. 240 km Vi
R | End Thre.
Tk 1.4000 wavelengin 12ou nm | (il

Figure 3-9. Range Configuration

Use A and ¥ to select an adequate range. Press Enter to confirm.

Notes:

+ "Auto” means automatic measurement. When this function is selected, the instrument automatically selects an adequate
range and pulse width for the measurement. The process of measurement does not require any intervention by the user.

+ "Auto” is the default setting.
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Pulse Width Configuration
The selection of pulse width affects the dynamic range and resolution of the measurement. With a narrow pulse width there will

be higher resolution and smaller deadzone; however, the dynamic range will be decreased. A wide pulse width will bring higher
dynamic range and measure comparatively longer distance, but resolution and deadzone will be increased. Therefore, users
should make the choice between dynamic range and deadzone.
The options for pulse width will change according to the distance range selected.

Under the parameter configuration menu use A and ¥ to highlight “PulseWidth.” Press Enter to select a value (Figure 3-11).

Press K to exit.

= iy

4
\< PulseWidth B
Ave T 100 ns /

v Time 300 ns g

Wavelength 1 Ous 2
Meas Mode 7 ’ Sus E
PM/LS : 2
Length Units Meter [m] *
IOR 1.4666 .

| | Scat. Coet. -52.1dB -
¢ | Nrefl Thre. 0.20 dB r
A | Refl.Thre. -52.00dB v
R | End Thre. 3.00dB )
ok 1.4000 wavelengtn 1200 nm (]

Figure 3-11. Pulse Width Configuration

Use A and ¥ to highlight the pulse width. Press Enter to confirm.

Notes:

+ "Auto” is the default setting.

« When the range is set to “Auto,’ the pulse width automatically is set to “Auto.”

Average Time Configuration

Average time will affect the SNR directly. The longer the average time is, the higher SNR is, as well as dynamic range. Therefore,
when measuring long-distance optical fiber, a long average time should be selected in order to review events at the long-

distance end.

Under the parameter configuration menu use A and V¥ to highlight “Avg. Time.” Press Enter to confirm (Figure 3-12).

Press K to exit.
TR
et 15| ?
. | PulseWidih = =
il Ave . Time e =
Wavelength 1'min z
Meas.Mode 2min 4
PM/LS 3 min I
Length Units 12
IOR 1.4666 ¥
Scat.Coef, -52.1dB *
s | NreflThre. 0.20 dB [
4 | Refl.Thre. -52.00dB v
R | End Thre. 3.00dB B
ok 1.4000 wavelengn 12ov nm (il

Figure 3-12. Average Time Configuration

Use A and ¥ to highlight the pulse width. Press Enter to confirm.

Notes:
+ There are five levels of predefined average time: 155,30 s, 1 min, 2 min, and 3 min.
+ The default setting is “30 s.”

Wavelength Configuration

Under the parameter configuration menu use A and V¥ to highlight “Wavelength.” Press Enter to change the
wavelength (Figure 3-13).
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[oi] @

Range Auto -

\ PulseWidth Auto =
" | Avg.Time 1310 nm =
:
Meas. Mode Averaging r
PM/LS i
Length Units Meter [m] 12
IOR 1.4666 >

| | Scat. Coef. -52 .1dB *
¢ | Nrefl. Thre. 0.20 dB *

A | Refl. Thre, -52.00dB ;'

R | End Thre. 3.00dB B

J(E1S 1.4000 wavelengu 135U nm | ulll

Figure 3-13. Wavelength Configuration

Measurement Mode Configuration

There are two kinds of measurement mode: averaging and realtime. Under realtime mode the 930XC will undertake realtime
measurement for the connector of exterior fiber and refurbish the measured trace. While under realtime mode, press Run/Stop
to stop; otherwise it will measure continuously. Under Averaging mode the tool will average the data within the measure time,
which is set by the user. When exceeding the set time, it will stop automatically and display the result. In general, averaging is
the preferred mode.

Under the parameter configuration menu use A and V¥ to highlight “Meas. Mode.” Press Enter to select “Averaging” or

1.800.561.8187

“Realtime” mode (Figure 3-14). Press k1 to exit.

o By

Range Auto ]

M PulseWidth Auto E
AvgTime 30s =N
Wavelength 1550 nm :‘L
mmua_ Averaging +
PM/LS &
Length Units Meter [m ] :
IOR 1.4666 o

|| Scat.Coet. -52.1dB ’
| € | NreflThre. 0.20dB "
A | Refl. Thre. -32.00dB v
R | End Thre. 3.00 dB B
| (6T 1.4000 wavelength 135V nm il

Figure 3-14. Measurement Mode Configuration

Power Meter, Laser Source, and VFL Configuration

Under the parameter configuration use A and ¥ to highlight “PM/LS" and press Enter to enter PM/LS interface (Figure 3-15).

Refer to “Power Meter, Laser Source, and VFL Settings” in Section 4 for details.

Figure 3-15. Power Meter and Laser Source Configuration

Range Auto _?
|| PulseWidth Auto p
- Avg Time 30s > CwW Py
Wavelength 1550 nm ].l. 1310nm VEL
Meas. Mode Averaging 1 Ref: -10:00dBm 'l
Mivis v
Length Units Meter [m
IORg 1.4666 L] 17 -20.185 @a
Scat. Coef. -52.1dB X
¢ | Nrefl. Thre. 0.20dB r
| Refl. Thre. -52.00 dB ol i
R | End Thre. 3.00dB B
*
10K 1.4000 wavelength 1350 nm  {iy)
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Length Units

Under the parameter configuration menu use A and ¥ to highlight “Length Units.” Press Enter to select the desired units of
measurement (Figure 3-16). Press K1 to exit.

= |
Range Auto J
L1}
k PulseWidth Auto B
ok
Wavelength Meter[m] E
Meas. Mode Feet[ft] s
PMILS Miles[mi] E
12
IOR 1.4666 Lj
| | Scat. Coet. -52.1dB *
¢ | Nrefl, Thre. 0.20 dB [
A | Refl. Thre. -52.004dB
R | End Thre. 3.00 dB ¥
Tk 1.4000 WUVEIEIIgUL 1 120V nm (il

Figure 3-16. Length Units

Index of Refraction (IOR) Configuration
Because IOR is a key factor affecting the speed of laser transmission in optical fiber, the IOR configuration has a direct impact

on the accuracy of measurement. In general, the IOR parameter is provided by the optical fiber manufacturer, and it can be set to
the accuracy of four digits after the decimal point between 1.0 and 2.0.
Under the parameter configuration menu use A and ¥ to highlight “IOR.” Press Enter to enter a value (Figure 3-17).

Press K1 to exit.

e
B
Range Auto ]
k PulseWidth Auto -
Avg . Time 30s g
Wavelength 1550 nm ]l
Meas.Mode Averaging 3
PM/LS Oft T
Length Units Meter [m ] B
1. 666 i
Scat.Coef. -52.1dB '+
| 5 | Nrefl Thre. 0.20dB [
o | Refl Thre. -52.00 dB v
R | End Thre. 3.00dB B
Iox 1.4000 wavelengin 15U nm g

Figure 3-17. IOR Configuration

Use « and P> to adjust the position of the highlighted area. Use A and ¥ to change the digits. After setting, press Enter to

confirm.

Scatter Coefficient Configuration
Scatter coefficient determines the value of backscatter power. This configuration affects the calculation of reflection value.
Under the parameter configuration menu use A and ¥ to highlight “Scat. Coef.” Press Enter to enter a value (Figure 3-18).

.|
Range Auto g
k PulseWidth Auto e
Avglime 30s Ell
Wavelength 1550 nm iL
Meas. Mode Averaging »
PM/LS Oft L
Length Units Meter [m] *
IOR 1.4666 .
u . 1dB -
Nrefl. Thre. 0.20 dB r
(A | Refl.Thre. -52.00dB b
R | End Thre. 3.00 dB B
IO 1.4000 wavelengin 120U nm il

Figure 3-17. IOR Configuration
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Press X1 to exit.

Use « and P> to adjust the position of the highlighted area. Use A and ¥ to change the digits. After setting, press Enter to
confirm.

Non-reflection Threshold Configuration

This configuration has direct impact on the listing of insertion loss events. Only events > to this threshold will be listed.

Under the parameter configuration menu use A and ¥ to highlight “Nrefl. Thre.” Press Enter to enter a value (Figure 3-19).
Press X1 to exit.

TR ‘
Range Auto -!5
L PulseWidth Auto £
Avg.Time 30s =
Wavelength 1550 nm g
Meas.Mode Averaging 1
PM/LS Oft 1
Length Units Meter [m] 1t
IOR 1.4666 .
Scat.Coet. -52.1dB *
E @.20dB | r
| ReflThre. -52.00 dB >
R | End Thre. 3.00dB B
IOK @ 1.4000 wavelengtn 155U nm (Ml

Figure 3-19. Non-reflection Threshold Configuration

Use « and P> to adjust the position of the highlighted area. Use A and ¥ to change the digits. After setting, press Enter to
confirm.

Note: The default setting is “0.20 dB.”

Reflection Threshold Configuration
This configuration has direct impact on reflection events listing. Only reflection events > to this threshold will be displayed in the

events list.
e
Range Auto -!%
K PulseWidth Auto o
Avg Time 30s _7
Wavelength 1550 nm z
Meas.Mode Averaging 3
PM/LS Off L
Length Units Meter [m] 2
IOR 1.4666 N
| | Scat. Coef. -52.1dB N
& | Nrefl. Thre. 0.20 dB :
A -8 .004B |
R | End Thre. 3.00 dB B
ok 1.4000 wavelengin 125U nm (il

Figure 3-20. Reflection Threshold Configuration

Under the parameter configuration menu use A and ¥ to highlight “Refl. Thre.” Press Enter to enter a value (Figure 3-20).
Press X to exit.

Use « and P> to adjust the position of the highlighted area. Use A and ¥ to change the digits. After setting, press Enter to
confirm.

Note: The default setting is “~52.00 dB.”
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End Threshold Configuration

This threshold is the end threshold of optical fiber. If the end threshold equals 3.0 dB, then the first event with insertion loss > 3
dB will be considered the end of the optical fiber. If the value is set to 0 dB, there will be no end threshold.

Under the parameter configuration menu use A and V¥ to highlight “End Thre.” Press Enter to enter a value (Figure 3-21).

Press X to exit.

] ; ; ; ="
Range Auto .?
‘L PulseWidth Auto -
Avg.Time 30s _7
Wavelength 1550 nm ;l-l
Meas .Mode Averaging K
PM/LS Off .
Length Units Meter [m] +
IOR 1.4666 T
Scat. Coef. -52.1dB *+
s | Nrefl. Thre. 0.20 dB r
7\ | Refl. Thre. -52.00dB F
R N 005 e
ok 1.4000 wavelengul  © 135U nm [(il]

Figure 3-21. End Threshold Configuration

Use « and P> to adjust the position of the highlighted area. Use A and ¥ to change the digits. After setting, press Enter to
confirm.

Note: The default setting is “03.00 dB."

Delete File

This function deletes saved traces.

Under the parameter configuration menu use A and V¥ to highlight “Delete File.” Press Enter to enter (Figure 3-22).
Press K1 to exit.

i E

Range Auto .g
Select File:0 118/1000 z
= =
Trace001 27-May-2013 10:30 ;l
Trace002 Range: 80km =:l
Trace003 Pwidth: 2.5us | o
Trace004 Wavelen.: 1550nm || -,
Trace005 |
Trace006 [Delete |[Cancel | P
Trace007 *
Trace008 | SelAll HFormat| &
Delete File B
1UK 1.4000 wavelengtn: 1>>unm |l

Figure 3-22. Delete File

Use A and ¥ to choose the files to delete, and press Enter to confirm. Or use the arrow keys to choose “SelAll,” and press Enter
to select all files.

One or several files can be deleted at a time. Use the arrow keys to select “Delete.” Press Enter, and choose “Yes” to delete or
“No” to not delete. Choosing “Cancel” will exit the Delete menu.
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Format Memory
Press format memory to format the internal memory.

Time Configuration

L

Range Auto . a
Sel -
Warning: =4
Low-level format may El
damage flash memory, 1
continue? d n

o e

:
Yes I‘ iy

r

Trace008 ‘|bclAll [[Format] | §
Delete File B
LUK © 1.4000 wavelength: 15>0Unm |{lll

Figure 3-22a. Format Memory

Time configuration is used to change system time.
Under the parameter configuration menu use A and ¥ to highlight “Time (y-m-d).” Press Enter to change (Figure 3-23).

Press K1 to exit.

AT
Avg. Time 30s -?
M Wavelength 1550 nm =
Meas. Mode Averaging l
PM/LS Oft '1
Length Units Meter [m] +
IOR 1.4666 L
Scat. Coet. -32.1dB -
Nrefl. Thre. 0.20 dB S
Refl . Thre. -52 .00 dB +
| ¢ | End Thre. 3.00dB r
A Delete File _ 4
R TR 208 -05-2710 :3020 | |4
ok 1.4000 Wwavelength 1550 nm iy

Figure 3-23. Time Configuration

Use « and P> to adjust the position of the highlighted area. Use A and ¥ to change the digits. After setting, press Enter to

confirm.

Auto Off Configuration

This function conserves battery power. When auto off is enabled, the instrument will automatically power off when idle for 5

minutes.
L ‘
Wavelength 1550 nm -?]
'\ Meas. Mode Averaging =
PM/LS Oft El-l-
Length Units Meter [m] iL
IOR 1.4666 +
Scat. Coef. -52.1dB L
Nrefl. Thre. 0.20dB +
Refl. Thre. -52.00dB 'I
End Thre. 3.00dB +
[ ¢ | Delete File r
4 | Jime (v -m-d) __ 2005 -05-27 10 :30:20 4
Ao OF Off B
IOk 1.4000 wavelengtn 130 nm (il

Figure 3-23. Time Configuration
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Under the parameter configuration menu use A and ¥ to highlight “Auto Off.” Press Enter to switch between “0Off” and “On”
(Figure 3-24). Press K1 to exit.
Note: The default setting is “On.”

Language Configuration

TR
2
Meas. Mode Averaging J
k PM/LS Oft =
Length Units Meter [m ] -
IOR 1.4666 ;ll
Scat. Coet. -52.1dB E
Nrefl. Thre. 0.20dB T
Refl. Thre. -52.00dB .
End Thre. 3.00dB :
Delete File +
s | Time(y-m-d) 2005 -05-27 10 :30:20 r
4 | Auto Off Off | 4
A English ¥
TOK 1.46b0 wavelength 1350 nm il

Figure 3-25. Language Configuration

There are two language options: English and Chinese.
Under the parameter configuration menu use A and ¥ to highlight “Lang./ ¥ & ." Press Enter to switch the language
(Figure 3-25). Press K1 to exit.

Contrast Adjustment of LCD

The contrast of the LCD can be adjusted.

PM/LS Oft 7
K' Length Units Meter [m] -
- | IOR 1.4666 ‘ 4
Scat. Coef. -52.1dB =l
Nrefl. Thre. 0.20dB 3
Refl. Thre. -52 .00dB ﬂ?
End Thre. 3.00dB ’
Delete File *
Time(y-m-d) 2005 -05-27 10 :30:20 i3

¢ | Auto Off Low High
R | e
o IT— o
TOR 1.46606 Wavelength 1550 nm 1l

Figure 3-26. Contrast Adjustment of LCD

Under the parameter configuration menu use A and ¥ to highlight “LCD Contrast,” Press Enter to adjust (Figure 3-26).

Press X1 to exit.

Use « and P> to adjust the contrast. After adjusting, press Enter to confirm.

Color Mode Setting
This setting changes the color scheme of the display.
-g
Length Units Meter[m] a
IOR 1.4677 -
Scat.Coef. -82.0dB ?7
Nrefl.Thre. 0.20dB 0
Refl.Thre.  -52.00dB >
End Thre. 3.00dB n
Delete File i
Time(y-m-d) 2005-05-27 10:30:20 :
Auto Off Colorl ¥
SlLang./ift 5 "~
A LCD Contrast Calor3 | <
gColor Mode Black/White B
[ UK L4017/ wavelengin: 12>>unm | i

Figure 3-27. Color Mode Setting
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Under the parameter configuration menu use A and ¥ to highlight “Color Mode.” Press Enter to choose a different mode
(Figure 3-27). Press k1 to exit.
Use A and ¥ to highlight the desired color mode setting. Press Enter to confirm the selection.

Default Setting
This function is used to set the OTDR parameters to factory settings. These parameters include: range, pulse width, average
time, I0R, non-reflection threshold, reflection threshold, end threshold, and scatter coefficient.

%o

IOR 1.4677 a

‘.k Scat.Coef. -82.0dB S
"INrefl.Thre. 0.20dB 3
Refl.Thre.  -52.00dB =l
End Thre. 3.00dB 1
Delete File n
Time(y-m-d) 2005-05-27 10:30:20 1t
Auto Off Off -
Lang./ifi 75 English 13

g |LCD Contrast r
A Color Mode |
R Load Delault yB
[UK L.40// wavelengn: 1>>unm | (i

Figure 3-28. Default Setting

Under the parameter configuration menu use A and ¥ to highlight “Load Default.” Press Enter to choose a different mode
(Figure 3-28). Press K1 to exit.

Use A and V¥ to highlight “Yes” or “No.” Press Enter to confirm.

Help

The Help function provides access to the quick reference screen.

Under the parameter configuration menu use A and V¥ to highlight “Help.” Press Enter to display the quick reference screen
(Figure 3-29). Press k1 to exit.

TR -g
Scat.Coef. -82.0dB 2
Nrefl.Thre. 0.20dB e
~|Refl.Thre. -52.00dB 97
End Thre.  3.00dB 2l
Delete File 1
Time(y-m-d) 2005-05-27 10:30:20 n
Auto Off Off 1t
Tt nig English :
LCD Contrast Ly
s [Color Mode Color 2 r
Load Default [
A
5 B
Or L.401/ wavelength: 1>3unm |
Quick reference Quick reference
1. Connect the fiber and OTDR. 6. Press dor ) to move active marker.
2. Press A orw¥to select icon. Press 7. Select {}or f% to zoom trace
‘Enter’ to activate function. horizontally, and select [l¥or n¥
3. Select/Bto set parameters: IOR, to zoom trace vertically.
Scat. Coef., pulsewidth, range, 8. Selectas to switch markers.
avg.Time, Refl. Thre., NonRefl. Thre 9. SelectMor<$to browse event.
and End Thre etc. 10.Select® to save files.
4. Press ‘Run/Stop’ to start... 11.Select (=2 to open saved files.
5. Press K)to view measure results. Warning: Always Avoid Naked Eyes
Exposed to Laser!
(4Page Up P Page Down K)Quit) (dPage Up P Page Down X¥Quit)

Figure 3-29. Help
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Battery Recharge Status

When the 930XC is powered off and powered through the AC/DC adapter, the “CHARGE" indicator on the interface panel
(Figure 2-1) will be lit. When the battery is fully recharged, the indicator will turn off.

When the instrument is powered on and powered through the AC/DC adapter, the internal battery is automatically recharged.
The icons mean the following:

Battery is being recharged

El Battery is fully charged

When the 930XC is powered off and powered through the AC/DC adapter, the “CHARGE” indicator on the interface panel
(Figure 2-1) will be lit. When the battery is fully recharged, the indicator will turn off.

No power
Low power
Half power

More than half power

g

Full power
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Section 4. Trace Measurement and Processing of Existing
Traces

Graphical User Interface (GUI) Instructions
When the 930XC is first turned on, an introductory screen appears on the LCD (Figure 4-1).

&F TEMPO

COMMUNICATIONS

930XC-XXX

--- Version X.X ---

SSSSS>55S5>5>555555>5>>>>

Figure 4-1. Power On Screen

Three seconds after the instrument is turned on, a quick reference screen appears (Figure 4-2).

1. Connect fiber to optical port.

2. Press ‘Run/Stop’ to start... %l

3. @ or & to browse event table JiL

K) to view trace parameters o

EX2

)

Avoid Eyes Exposed to Laser! Tt

+

@

--Km/Div --dB/Div Para-1 3

Ave.Time: --s Samp.Dist.: -- Mg
Range: --km PulseWidth: ---

IOR 8§ =gy==== Wavelength: ----nm|{ny

Figure 4-2. Quick Reference Screen

Trace Measurement

One complete trace can be obtained for each measurement. The 930XC can also load a saved trace.

ACAUTION

Instrument damage hazard:

Make sure that the optical fiber or cable is not in use and there is no laser beam in the fiber before
testing with this unit.

Failure to observe this precaution may result in injury and may damage the unit.
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Setup

Connect the optical fiber directly to the 930XC optic output. No tools are required.

+  Clean the connectors. Refer to Section 5 of this manual for details.
+  Clean the tie-ins, making sure they are compatible (APC or UPC).
«  Connect optical fiber to the 930XC.

For details relating to parameter configuration, refer to “Parameter Configuration” in Section 3. If the parameters are unclear, use
the default parameters of the instrument.

Note: Range is set to “Auto” when auto measurement is on.

Auto Trace Measurement

Auto measurement can be used if the length of optical fiber is unknown. The 930XC will select an adequate range for
measurement.

For auto measurement follow these steps:
1. Set the range to “Auto.” Refer to “Parameter Configuration” in Section 3.

2. Press Run/Stop to start the measurement (Figure 4-3).
i T ; T

B]!.BZH: B39.828
& | S S e
. o EN | B
; Ju ; o
et - ; |4 S : |4
W o [ U 1 | W p
--Km/Div --dB/Div 3 8Km/Div 5.00dB/Div  * 3

Ave.Time 00:30 * Ave.Time 00:30 .
Time Passed: 00:16 (G Time Passed: 00:30 e ”
filly (LU

Figure 4-3. Measuring

3. Interface:

+ Ave. Time: 00:30: Measure time, which is set by user, is 30 seconds.

Time Elapsed: 00:16: Total measurement time has passed 16 seconds.
- ¥— : Blinking of this icon means laser is active.

Note: After a certain period of time, the trace displays on the GUI. The trace in the figure below is a trace during measurement,
which will be refreshed for every certain period of time to demonstrate the whole process in realtime. But at the end of
measurement the trace will be complete, as shown in Figure 4-4.

s

5w 50

-+
*

n

@ : 3

8Km/Div 5.00dB/Div tracel Event :

No.: 2/4 ML  Location: 25.308km B
Refl.:-38.12dB Ins.L.: 0.85dB

Attn.: 0.22dB/km Cum.L.: 5.57dB i

Figure 4-4. Trace Measurement
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Manual Trace Measurement
To achieve optimal measurement results, set the parameters manually.
1. Set the range. Refer to “Range Configuration” in Section 3.
2. Press Run/Stop to start the measurement. The process is the same as with auto measurement.

Live Traffic Warning

Connect the optical fiber directly to the 930XC optic output. No tools are required.If the 930XC is connected to a fiber with live
traffic, the warning of “Traffic Signal Detected!” will be displayed after Run/Stop is activated. Disconnect the fiber under test and
quit the measurement. To avoid damage to the 930XC, ensure that live traffic is removed from the test fiber before reconnecting
to the 930XC.

1. Connect fiber to optical port
2. Press ‘Run/Stop’ to start
3.4 Traffic Signal Detected ! I
' &
Avoid Eyes Exposed to Laser ! H
P
T
--Km /Div_--dB/Div Para-l | @
Ave.Time: --s Samp. Dist.:  -- Mg
Range: --km Pulse Width: ---
IOR : Wavelength: ----nm |(0

Figure 4-5. Live Traffic Warning

Reasons for Trace Measurement Failures
Figure 4-5. Live Traffic Warning
If measurement failures occur, the reason may be one of the following:

Events may be too close to each other: Shorten the pulse width and try again. If failure still occurs, try measuring at
the other end of the optical fiber.

Low SNR: Use a wider pulse or increase average time and try again.
Incorrect parameter configuration: Check the parameter configuration and try again.

Information Window

The information window displays the following items: measurement parameters, analysis parameters, and information regarding
marker A/B.

For details regarding the information window, refer to “Information Window” in Section 3.

Switching between Information Window Items

Under GUI (Figure 4-4) press k1 and the items in the information window will display in this order: measurement parameters -
analysis information — events list = marker A/B information — fiber information - measurement parameters.

Reviewing Events List

Under GUI (Figure 4-4) press K7 until the events list information appears in the information window.

Use A and ¥ to highlight T or !, and then press Enter to review the events list. Use T to browse upward, and ! to browse down-
ward. To browse up and down the events list using the keypad, press Shift + and Shift + Enter.

Reviewing Marker A/B Information

Switching between Marker A/B

Under GUI (Figure 4-4) use A and ¥ to highlight #/,, and then press Enter to switch betweeen marker A/B.

Use < and P> to move marker A or B.
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Information between Marker A/B
Under GUI (Figure 4-4) press k7 to switch information window to marker A/B information.

Use « and P to move marker A or B.

Zoom a Trace

Zoom out Trace Horizontally

To review the details of an event more closely, follow these steps:
1. Under GUI (Figure 4-4) use A and 'V to highlight #%, and then press Enter to zoom out the trace horizontally.
2. Use « or > to move the marker to the event point being reviewed.
3. Refer to “Switching between Marker A/B” above for more information.

Zoom in Trace Horizontally

Under GUI (Figure 4-4) use A and 'V to highlight 3, and then press Enter to zoom out the trace vertically.

Zoom out Trace Vertically

To review the details of an event more closely, follow these steps:
1. Under GUI (Figure 4-4) use A and V¥ to highlight "%, and then press Enter to zoom out the trace vertically.
2. Use « or > to move the marker to the event point being reviewed.
3. Refer to “Switching between Marker A/B” above for more information.

Zoom in Trace Vertically
Under GUI (Figure 4-4) use A and ¥ to highlight I*, and then press Enter to zoom in the trace vertically.

Zooming Shortcuts
+  To zoom in horizontally using the keypad, press Shift + p.
To zoom out horizontally using the keypad, press Shift + «.
To zoom in vertically using the keypad, press Shift + A.
To zoom out vertically using the keypad, press Shift + Enter.

Re-analyze a Trace

If the test result at a certain threshold is not adequate, it can be re-analyzed using this function to change the threshold. This
function can be effective while the OTDR is disconnected from the fiber.

Under the parameter configuration menu edit the threshold value, and then press X7 to exit the parameter configuration menu.
Press [El to re-analyze the trace.
Save a Trace

When auto or manual measurement is finished, the measurement trace can be saved. The contents of a saved trace include the
trace curve and related information of the trace.

1. Under GUI (Figure 4-4) use A and 'V to highlight &, and then press Enter to enter (Figure 4-6).

LRLR H ) /,?4

L} 5]

Space Used:118/1000 %1

| [BRACEO | =

>

ABCDEFGHIJKLM &

NOPQRSHUVWXYZ .

0123456789 _ .

ng

‘ Save HCancelH Del ‘ @~

8Km/I a-1|g

Avg.Time: 30s Samp.Dist.:  5.11m | Ap
Range: 80km PulseWidth: 2.5us

IOR : 1.4666 Wavelength: 1550nm |1

Figure 4-6. Save a Trace
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2. Inputfile name: Use A, ¥, 4, and P> to choose the alphanumeric characters one by one, and then press Enter to
confirm. The filename can be a maximum of eight characters in length.

3. Savefile:Use A, ¥, 4, and P> to highlight “OK,” and then press Enter to save.
Cancel saving file: Use A, ¥, 4, and P> to highlight “Cancel,” and then press Enter to cancel the save file operation.

5. Delete alphanumeric characters: Use A, ¥, 4, and P> to highlight “Delete,” and then press Enter to delete the
characters.

6. Memory space: “118/1000" means that total memory space is 1000 files; 118 files have been saved so far.

Browse Saved Traces
1. Under GUI (Figure 4-4) use A and V¥ to highlight C%-, and then press Enter to confirm (Figure 4-7).

B 1 /@

I =

.~ |Select File: 118/1000 =

27-May-2013 10:30 ||[Z]]

Trace002 Range: 80km i1

Trace003 Pwidth: 2.5us | I

Trace004 Wavelen.:  1550nm |

Trace005 nt

_ |Trace006 !\4

| 8K Trace007 e =

Ayl Trace008 \ Open |\Cance1| ¥
Range: 80km PulseWidth: 2.5us

IOR : 1.4666 Wavelength: 1550nm |l

Figure 4-7. Browse Saved Traces

2. Use A and V¥ to highlight the trace, and then use <« and P> to choose “Open” or “Cancel.” Press Enter to confirm.
3. Memory space: “118/1000" means that total memory space is 1000 files; 118 files have been saved so far.

Alter Measurements in Realtime Testing

To alter measurements in realtime testing, follow these steps:
1. Use A and ¥ to highlight /2 (i.e., parameter configuration), and then press Enter. A parameter box will appear at the
bottom of the screen.
2. Use « and P> to move to the parameter to be changed (Figure 4-9), and then press Enter.
3. Use A and V¥ to change the value. Select “Averaging” to choose Averaging testing.
4. Press "OK" to exit the parameter configuration menu.

LESTE

BOKm/Div 5.00dB/Div * Event

Range: JININ PulseWidth: 2.5us

Wavelength: 1550nm I0R: 1.4666
<Averaging> <K=

Figure 4-9. Alter Measurements in Realtime Testing
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Power Meter, Laser Source, and VFL Settings
Optical Power Meter Settings

1. Enter PM/LS interface as described in “Power Meter, Laser Source, and VFL Configuration” in Section 3. Use A and ¥ to
highlight “OPM", and press Enter to enter OPM interface (Figure 4-10)

W =
1310nm VFL
Ref: -10:00dBm K

-20.185 wn

BV ]

Figure 4-10. Optical Power Meter

2. Use d and P> to toggle between calibrated wavelengths. Press Enter to enter OPM measurement setting interface (Fig-

ure 4-11)

131 0nm
=10, 00dBm gLs
dBm VFL
K

_______ Low

dBm
44D {im

Figure 4-11. OPM Measurement Setting

3. Use A and ¥ to highlight the parameter to be adjusted, and press Enter to enable adjustment. Press <« and P> to adjust
digit position, and press A and V¥ to adjust the value. Press Enter again to confirm and press kK7 to exit setting.

Zeroing the Optical Power Meter

Isolate OPM port from outside light input with dust cap tightened securely.
Enter “Setup” and find “PM/LS".

Enter “PM/LS" and select “OPM".

In OPM interface, press Enter to find OPM popup menu.

Find “Zero”, and press Enter to zero the OPM.

akRrwd =
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Stabilized Laser Source Settings

1. Enter PM/LS interface as described in “Power Meter, Laser Source, and VFL Configuration” in Section 3. Use A and ¥ to
highlight “SLS”", and press Enter to enter SLS interface (Figure 4-12).

PCW ;E
1310nm VEL
v

Laser Off

By ]

Figure 4-12. Stabilized Laser Source

2. Use « and P> to toggle between SLS working wavelengths. Press Enter to enter SLS setting interface (Figure 4-13).

PCH 1310nm OFN
131 0nm [Mod PCW SLS
On/0ff Off VFL
K

Laser Off
4L p |

Figure 4-13. Stabilized Laser Source Setting
3. Use A and ¥ to highlight the parameter to be adjusted, press Enter to confirm, and press K7 to exit setting.
Visible Fault Locator Settings

1. Enter PM/LS interface as described in “Power Meter, Laser Source, and VFL Configuration” in Section 3. Use A and ¥ to
highlight “VFL", and press Enter to enter VFL interface (Figure 4-14).

CW OFN
gL
K
Laser Off
4 Mod p {m

Figure 4-12. Stabilized Laser Source
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2. Use «and P> to toggle between VFL working modes. Press Enter to enter VFL setting interface (Figure 4-15).

CW ) OFM
On/Off Qff als

gEl

Laser Off

41ad p )

Figure 4-15. Visible Fault Locator Setting

3. Use A and ¥ to highlight the parameter to be adjusted, press Enter to confirm, and press &7 to quit setting.

930XC Link Viewer

Macrobend Analysis will find events that are high losses at 1550nm and little or no loss at 1310nm. To activate this feature
set the Wavelength setting to 1310+1550nm.

Display Mode

Link Viewer is a graphical way of presenting OTDR test results. The user can manually switch between Link Viewer mode and
Trace mode by toggling the Display Mode setting as shown below.

U LD AR

The test settings in Link Viewer mode are the same as in Trace mode, parameters as Range, Pulse Width, Measuring Mode
(Averaging/ Real Time), Time, IOR etc. need proper configuration for reasonable test results. The user can start a test either
in Link Viewer Mode or Trace Mode. In Link Viewer mode, OTDR test results are presented in a way shown below.
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Events are presented by icons in link view, viewing each one of the events is the same as in trace view with the same hot
keys. The symbol ¥ indicates the selected event with event number. The overall fiber link information is shown in the black
line pictorial above the event link with relative position marks (white vertical lines) and distance information (total length and
location of selected event).

Events Summary

b Beginning of fiber
Splice

Connector / Coupler
Macrobend

End of fiber

Events will be highlighted if the respective event is greater than the relevant setting in the Pass/Fail menu.

Pass/Fail Setup

Pass/Fail settings are accessed as shown below.
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Pass/Fail Settings

Ins. Loss

Measured events with insertion loss greater than this setting will be displayed red.
Reflectance

Measured events with reflectance greater than this setting will be displayed red.

Total Attn.

Measured links with a total attenuation greater than this setting will be displayed in red.

Total Loss

Measured links with a total loss greater than this setting will be displayed in red.

Total ORL (Optical Return Loss)

If the total ORL for the link is equal to or greater than this setting the link will be displayed red.
Thres. On/Off

Enable / Disable Pass/Fail function. On provides Pass/Fail analysis. Off disables the analysis.

Macrobend Analysis

Macrobend Analysis will find events that are high losses at 1550nm and little or no loss at 1310nm. To activate this feature set the
Wavelength setting to 1310+1550nm.

Use the Delta to set the Macrobend sensitivity. Lower Deltas will find progressively smaller Macrobends. Please note when
single wavelength is selected, Delta is not available for setting. Macrobend analysis is not available in 1310nm and 1550nm
measurements.

T
e
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The screenshot below shows the same measurement in conventional Trace mode.
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Section 5. Calibration and Maintenance
ACAUTION

Electric shock hazard:
Do not expose the unit to extremes in temperature or high humidity. Refer to “Specifications.”

Turn the unit off, disconnect from power, and make sure the laser source is off before
cleaning.

Failure to observe these precautions may result in injury and may damage the unit.

Calibration Requirements

Calibration of the instrument is recommended every two years. Contact Tempo for proper
calibration services.

Maintenance and Replacement of Batteries

The 930XC has two batteries: a NiMH battery to power the instrument and a realtime clock (RTC)
battery for data retention.

Note: Recharge the battery prior to use if the OTDR has not been used for one month.
To replace the NiMH battery (Figure 5-1):

1. Remove the battery compartment cover.

2. Remove the battery and disconnect the battery connector.

3. Replace the battery with the Tempo supplied replacement battery.

To replace the RTC battery (Figure 5-1):

1. Remove the NiMH battery as above.

2. Remove the RTC coin cell battery.

3. Replace using a CR1220. Insert the replacement coin cell with the positive side facing up.

Jack for y
Chargeable Battery/:-*'

/' RTG Clock
Battery

Figure 5-1. Replacing Battery
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Cleaning

When necessary, clean the case, front panel, and rubber boot with a damp cloth. Do not use
abrasives, harsh chemicals, or solvents.

Before Cleaning
e Make sure the power is off to the instrument.
* Make sure the laser source is off when cleaning any optical connectors.
* Make sure AC power is disconnected.

Cleaning Interfaces and Connectors

Interfaces must be kept clean. Isopropyl alcohol may be used to clean the optical output. Always
replace the protective dust caps when the unit is not being used, and keep the protective dust caps
clean. In addition, flanges must be cleaned periodically.

Notes:

e The diameter of optic core is 9 um, and the diameter of dust and other particulates ranges
from 1/100 to 1/1000 um. Dust and other particulates can cover part of the optical end and
therefore degrade the performance of the instrument.

* In addition, power density may burn dust into optical fiber and induce further damage
(for example, 0 dBm optic power may produce about 16000000 W/m*m power density in
single mode fiber). If this happens, the measurement will be inaccurate and damage will be
irreversible.

Tools for Cleaning Interfaces and Connectors
e Optical fiber cleaner (for cleaning optical connectors)
e Optical fiber cleaning rod (for cleaning optical outputs)
* Optical fiber cleaning tissue (for cleaning optical interfaces)
e Isopropyl alcohol
* Paper tissue
e Cleaning brush
e Cleaning swabs

e Condensed air
Procedure for Cleaning Interfaces and Connectors
1. Unscrew the adapter from the bulkhead.
2. Carefully clean the bulkhead and the inside of the adapter.

3. Screw the adapter back onto the bulkhead.

Figure 5-2. Flange
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Section 6. Specifications

MODEL 930XC-20C 930XC-30P 930XC-30F 930XC-20M
Wavelength (+ 20nm) 1310/1550 1310/1490/1550 1310/1550/1625 850/1300
Dynamic Range (dB)? 35 38/37/37 38/37/37 21/24
Event Deadzone (m)° m 1m m <2.5m
Attenuation Deadzone 4.5m 4.5m 4.5m <12m

Pulsewidth 5,10, 30, 100, 300, 1us, 2.5us, 10us, 20us 12, 30, 100, 275,

Tus/30, 100, 275, 1us,
2us
Selectable Ranges (km) 0.3,1.3,2.5,5,10, 20, 40, 80, 120, 160, 240 0.1,0.3,0.5,1.3,2.5,5,
0/0.1,0.3,0.5,1.3,2.5,
5,10, 20, 40, 80
Average Time 15s/30s/1 min/2 min/3 min
Distance Measurement +(1m + 5 X 10-5 x distance + sampling space)
Accuracy
Connector Type PC or APC (interchangeable FC, SC, ST)
Reflection Detect Ac- +4 dB
curacy
Attenuation Detect Ac- +0.05 dB/dB
curacy
Measurement Data Stor- 1,000 test curves
age
Data Transmission RS-232/USB port
Visual Fault Locator (VFL) -3dBm; 650nm
Optical Power Meter InGaAs
(OPM)
OPM Wavelengths 850, 1300, 1310, 1490, 1550, 1625nm
OPM Range +6 t0 -70dBm (+6 to -60dBm 850nm)
OPM Display resolution 0.01dB
OPM MOD Identification 1kHz, 2kHz
Stabilized laser Source Wavelength same as selected in OTDR mode < -7dBm
(SLS)
Power Supply NiMH chargeable battery/AC adapter
Battery Life Support over 8 hours operating on onecharge or over 20 hours standby
Operating Temperature -10°to 50° C
Storage Temperature -20°to 60° C
Relative Humidity 0 to 95% (non-condensing)
Weight 1.9 Ibs. (0.87 kg)
Dimensions 7.7"Hx3.9"Wx2.4"L(196mm x 100mm x 64mm)
Compliance CE, FCC, UL
Fiber Analysis Software Version 3.2
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Stabilized Laser Source Module

Specification 930XC-20C 930XC-20M 930XC-30F 930XC-30P
Wavelength Same as OTDR working wavelength
Output Power (dBm) >-7

Optical Power Meter Module

Specification 930XC-20C 930XC-20M | 930XC-30F 930XC-30P
Calibrated Wavelength (nm) 850/1300/1310/1490/1550/1625
Power Range (dBm) -70 ~ +6 (=60 ~ +6 @ 850 nm)
Detector Type InGaAs
Display Resolution (dB) 0.01
Accuracy +5% +0.01 nW (0.5 dB @ 850 nm)
MOD Identification 1K,2KHz

Section 7.

OTDR Trace Viewer Software

Trace Viewer software is an application developed for the 930XC OTDR. It allows the previously
stored measurement records in the instrument to be uploaded to a PC and to be displayed, saved,
or printed. This software provides a convenient data management function, which includes:
editing, analysis, browsing, saving, backup, printing, and ASCII format output.

Software Installation

Computer System Requirements

Requirements for operating system and hardware:
e PC with Intel Pentium III processor or higher
* Microsoft® Windows 98/2000/XP/Vista/7/8 operating system
*  Minimum 64 MB of internal memory
e Minimum 40 MB of available hard disk space
e 8-speed CD-ROM drive
* O-pin series port or USB port

Installation

Follow these steps to install the 930XC OTDR Trace Viewer software on a PC:

1. Start Microsoft® Windows.

2. Exit all other running applications that Windows is currently running.

3. Insert the installation disk into the CD-ROM drive, and locate the OTDR Trace Viewer folder.
4. Run 930XC OTDR Trace Viewer setup file to install.
5

Follow the step-by-step installation wizard instructions until installation is complete.
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Software GUI

Graphical User Interface (GUI)

After installing the 930XC Trace Viewer software, click “run” to view the main GUI (Figure 7-1).

930XC OTDR Trace Viewer - [] - o El
1 >File Edit View OTDR Window Help
2> = & ?
=] Trace [e@]=]|® Parameters ==
3 — 5
8 Marker Information | = [ | =
6

Event Table
No. [Type [ Locati.. [ ReflidB] [InsLoss[d.. [ Attn[dB/km] [ Cum.Loss|..| DistPrev.km] [ DistEnd[km] | Loss Prev.dB] | Comment |

(= @] = || @ Total FiberInformation [=| & ] &

8->
Figure 7-1. GUI

1. Menu

Tool bar

Trace display window (Spectral line)

Events list window (Events Table)

Measurement and analysis parameter window (Parameter Sheet)
Fiber information window (Fiber section information)

Fiber chain information window (Fiber chain information)

® N ok wDd

Status bar

Menu, Tool Bar, and Status Bar
The main GUI of the 930XC OTDR Trace Viewer software is shown in Figure 7-1.
The menu bar includes: File, Edit, View, OTDR, Window, and Help.

The tool bar is right below the menu bar. Use the mouse pointer to highlight a tool, and the
operation reference will pop up. The tool bar display can be turned on or off by clicking “Show
Toolbar” under the “View” menu. The tool bar provides shortcut keys to complex operations. All
the functions on the tool bar can also be accessed through the menu bar.

The status bar is at the very bottom of the GUI. It displays information or reference of the current
menu or tool bar application. The status bar is a brief summary of the current menu application or
tool bar function.
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File (F)

The functions enabled under the “File” menu (Figure 7-2) include: Upload Trace File, Open,
Multi-traces (add up to four traces to display) , Save, Save As, ASCII Export, Print Option,
Printing Preview, Print, Batch Print Preview, Batch Print, Batch Edit, and Exit.

Flz Edit View OTDR Windo
Upload Trace File...

{18 = 7 P Cir|=Cr
Multi-traces L4
Save Ctrl+5
Save As...

ASCIl Export...

Print Option...

Print Preview

Print Setup...

Print... Ctrl+P

Batch Print Preview
Batch Print
Batch Edit

Exit

1 Demo (4)
2 Demo (3}
3 Demo (2)
4 Demo (1)

Figure 7-2. File Menu

Edit (E)

Use the “Edit” menu (Figure 7-3) to edit the events list: Add Event, Modify Event, Delete Event
and Edit Trace (optical fiber) Information. Optical fiber information is explanatory text relating

to the trace file that users type in. For each measurement, users can save the measurement trace
with the 930XC. This software provides an interface for text input. For each trace file, users can
input related information (No. of cable, No. of fiber, type of fiber, beginning of fiber, end of fiber,
manufacturer, and technician. With this information, users can identify the corresponding relations
between trace file and fiber chain.

Edit View OTDR Window
Add Event

Modify Event
Delete Event

Edit Trace Information...
Figure 7-3. Edit Menu

View (V)

The “View” menu (Figure 7-4) controls the display of the tool bar, status bar, marker operation
and trace display (zoom in and out horizontally and vertically), and the display style of the trace.

View OTDR Window He

v Show Toolbar
« Show Status Bar

Lock Marker A B
Zoom out

View Full Trace
Analyze Insertion Loss
Analyze Reflectance
Length Units...

View Preferences...

Figure 7-4. View Menu
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Atrace is composed of many dots. To review the details of a trace, zoom in by drawing square
with mouse on selected trace area from upper left to lower right direction and zoom out by
drawing square from any other direction.

Lock Marker A and B to fix the distance between them.

Use “Analyze Insertion Loss” function to manually calculate the insertion loss of an event
(Figure 7-5).

& Trace 0.050 km/Div 2.3 dB/Div [fe)oEa] 52
: : : : i 0.62161 k]l 1 : : 2

o f B B o

Figure 7-5. Analyze Insertion Loss

Use “Analyze Reflectance” function to manually measure the reflectance of reflection event
(Figure 7-6).

L Trace 0.050 km/Div 2.3 dB/Div =B =2
; : : ; i 0.c2161 kmil : : : 3

Figure 7-6. Analyze Reflectance

Use the “Length Units” setting to select meters, feet, or miles as the unit of measurement. Note:
When the Trace Viewer application is opened, this setting defaults to the last unit of measurement
selected.

View Preferences refers to the trace display styles. Trace can be displayed in dots or solid line;
dashed line displays or not; selection of the event status bar.

OTDR (O)

The “OTDR” menu (Figures 7-7 and 7-8) provides a reanalysis function for acquired traces. Op-
erator can modify IOR, Scatter Coefficient, and event thresholds (Non-reflection, Reflection, and
End) per each wavelength to review correct results.

OTDR Window Help

ReAnalysis Event
Figure 7-7. OTDR Menu
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x|
—Acquisition Fiber Settings

Wavelongth [T -

10R || AGG6 Default
Scat. Coef[dB) |-52_1 Default

Analysis Parameters

MNon-Reflection Threshold Default

IIJ.Z dB
Reflection Threshold FE dB8  Default
|‘] dB

End Threshold Default

ililE (i

Apply Cancel |

Figure 7-8. Trace Reanalysis

Window (W)

The “Window” menu (Figure 7-9) controls the display of the subwindows: trace window, events
table window, parameter window, and fiber chain information. Tile function displays subwindows
in a layout similar to Figure 7-1. Other submenus take the selected window as the current active
window.

Window Help

Cascade

v Trace
EventTable
Parameters
Marker Information
Total Fiber Information

Figure 7-9. Window Menu

Help (H)
The “Help” menu (Figure 7-10) displays the version of the software.
Help
About OTDR Trace View...
Figure 7-10. Help Menu
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Information Subwindows

Trace Display Window

Click “Open...” under the “File” menu to open a trace file, and a trace curve will display in the
trace display window (Figure 7-11). The x-axis displays the distance (km); the y-axis represents
the backscatter power (dB). There are two markers, A and B; click either one to activate it. To
move the marker, click and drag with the mouse pointer; the position information will change
accordingly. By moving the marker, the horizontal distance and vertical power can be read
manually. Zooming in and out of the trace features depends on the activation of a marker. In
Figure 7-11 below, the sloped line represents backscatter from the optical fiber. The peaks are
reflective events in the fiber chain. The end of the fiber is shown by the sudden drop in optical
power, which is followed by noise. The symbols at the bottom of the window indicate the type of
event.

Trace 4.1 kmy/Div 6.0 dB/Div 1 =10] =]
; ; B 16.36073 km

Figure 7-11. Trace Display

Events List Window

Trace data collected by the 930XC will be processed automatically, and analysis results will be
displayed in the events list (Figure 7-12).

=l

Ewent Table

mmmmmm‘mm Loss Prev.[d] | Comment |

1 b Smrt 000000 -46.300 “— 2529358 -—
2 >~ Ho.. 122%.. -— 0005 -0.555 4 B27 12 22369 13.06963 4.827
3 4 e 25.29.. -23.907 - 0.191 0,00 1306969 — -4.832

Figure 7-12. Events List

The events list contains the following items:
¢ No.: Sequence of events in optical fiber chain.
¢ Type: Beginning, end, reflection, and non-reflection event.
¢ Distance: Distance from OTDR to event point.
¢ Reflection Value: Value of reflection event.
¢ Insertion Loss: Vertical decline of dB.

¢ Attenuation Coefficient: Value of attenuation per kilometer between current event point and
previous event point in optical fiber chain.

e Cumulative Loss: dB value of loss from 0 km to current event point.

¢ Dist. Prev. (km): Distance from the previous event.
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¢ Dist. End. (km): Distance from the end event.
e Loss Prev. (dB): Loss from 0 km to current event point.

e Comment: Notify other details of the event.

Parameter Window

The parameter window (Figure 7-13) displays the default parameters of the currently displayed
trace. Measurement parameters include: range, pulse width, average time, and wavelength.
Analysis parameters include: IOR, scattering coefficient, end threshold, non-reflection threshold,
reflection threshold, and samp. dist. For definitions of these parameters, refer to “Parameter
Configuration” in Section 3 of this manual.

NI

ange : 40,0 km

ulzeWidth : 300 ns
avelength : 1550 rm
I0R : 1. 46660
Scatter Coef. : -52.1 dB
Average Time : oo0:00:15
End Threshold : 3.000 dB

MRefl. Threshold 0.200 dB
Fefl. Threshold =52.000 dB
Samp. Diszt: 2.56 m

Figure 7-13. Parameters

Fiber Section Information Window

This window (Figure 7-14) displays the distance between marker A and B, attenuation coefficient,
and loss information. The two point loss is the difference of vertical power between marker A and
B. Two point attenuation is the two point loss of marker A and B divided by the horizontal distance
between marker A and B.

=10l x]
li-B: 970,63 m

2pt. Loss: 0. 181 dB

Zpt. Attn. 0. 186 dB/km

LS4 Attn. : 0.202 dB/km

Ins.Loss at 4: -.—— db

Refl, at A: -47. 6501 dB

Zpt. OFL: 43.212 db

Cum.Loss to A 0.732 dB

Figure 7-14. Fiber Section Information
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Fiber Chain Information Window

The contents displayed in this window (Figure 7-15) are date of measurement, length of fiber
chain, loss of fiber, attenuation, ORL, and event number of fiber.

"~ Total Fiber Information | -|I:I|i|
measure Date: 05/08/2012 13:44:27

Total Length: 6.43391 km

Total Loss: 2.717 db
Total Attn. : 0.422 dB/km
Total ORL: 27.833 dB

Event Number: 3

Figure 7-15. Fiber Chain Information

Software Functions

Upload Trace Data
Option 1:

Power off the 930X C, and then connect the 930XC to a PC via USB cable. Turn the 930XC on

and wait for PC to recognize 930XC as an USB memory device. Find “trace” folder to copy saved
files to PC.

Option 2:

Power off the 930XC, and then connect the 930XC to a PC via serial cable. Turn the 930XC on
and run the 930XC OTDR Trace Viewer software. Under the “File” menu, select “Upload trace
file...”, and the “Communications Settings” dialog box appears. Choose a communication port
(RS-232) and click “OK”. Choose the saved position of traces, and then start uploading data.

COMMUNCATIoNS Settings x|

Port |rs232 ;|| s |

R5232 Fal'.' "'I
G 1
EaudRate I!:'.. 'l'i LI
Matapit B -

I.'il IHE "'I

Figure 7-16. Upload Trace Data
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Browse Traces

Tool Bar

smHRE O caglTErRa|~[He|t]2]3]s

Move the mouse pointer over the tool bar and an explanation of the buttons will pop up.
Their functions are as follows:

+$¢3ﬂ@@@ﬂﬁﬂﬁﬁﬂ

A 4

®

Open file

Close file

Save file

Printing preview

Printing

Edit optical fiber information
Zoom out trace

Display whole trace

Zoom in trace horizontally

Zoom out trace horizontally

Zoom in trace vertically

Zoom out trace vertically

Analyze insertion loss (the five-point measurement to test the insertion loss)

Analyze reflectance
Lock marker A and B

Display version

’T| S| ‘ Trace number (in multi-trace display mode)
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Open Trace File

Select “Open trace file...” under the “File” menu, and choose the trace file to be reviewed

(Figure 7-17). Select “Tile” under the “Window” menu to automatically rearrange the subwindows
as shown in the figure below.

-] 930XC OTDR Trace Viewer - [c:\users\jia\desktop\25296.sor] - o IEd
File Edit View OTDR Window Help
sadbaelcaalTin ~ | ?
® Trace 4.1 km/Div_ 6.0 dB/Div [e=@)=]]|® Parameters ===
B16.35306km: [ Range 400 kn
PulseWidth 300 ns
Wavelength 1550 nn
ToR 1. 46660
"""""""""""""""""""""""""""""""""""""""""""""""""""""""" Scatter Coef. : -52.1 dB
werage Tine 00:00: 30
End Threshold 3.000 dB
IRefl. Threshold  0.200 dB
Refl. Threshold -52.000 dB
L\ [Samp. Dist 2.56 m
: ®  Markerinformation [o | & =
-B 8.94052 kn
; l2pt. Loss 1.707 4B
2pt. Attn. 0.191 dB/kn
il LSA Attn. 0.190 dB/kn
ns.Loss at A -2.448 dB
: Refl. at A1 -84.920 dB
] l2pt. ORL 33964 dB
" i un.Loss to &4 4.757 dB
Event Table = | @] = | @ TotalFiber Information [=|[ & ] =
No. [Type [ Locati.. | Refl(dB] [ Ins.oss[d... | Attn.[dB/km] | Cum.Loss[...| DistPrev.km] | DistEndlkm] | Loss Prev.[dB] | Comment | easure Date: 03/25/2013 13:06: 42
1 F Start 000000 -47.487 25.29358 = Total Length: 25.29358 kn
2 4 End 25.293. -37.429 0.188 4750 25.29358 4750 Total Loss: 4.749 B
Total Attn. 0.188 dB/kn
Total ORL 32.514 dB
Event Number: 2

Figure 7-17. Open Trace File

Zoom in and out of Trace

Trace curves are displayed in the trace window (Figure 7-17).

To view in more detail, drag the marker to the trace detail to be reviewed and then:
Zoom in trace horizontally: Click 44 on the tool bar.
Zoom out trace horizontally: Click {E' on the tool bar.

Zoom in trace vertically: Click JI2 on the tool bar.
Zoom out trace vertically: Click 71X on the tool bar.
« Whole trace: Click 4 on the tool bar.

Or zoom in by drawing square with mouse on selected trace area from upper left to lower right
direction, and zoom out by drawing square from any other direction.

Note:

Zoom in or out is centered on the trace features of the activated marker.

¢ The software supports floating menu operation. Right click the mouse on the window in order
to display the operations that can be performed, including zoom in and out of trace.

Review Trace Information

Trace information includes: trace measurement parameters, analysis parameters, fiber section
information, fiber chain information, and the events list.

1.800.561.8187
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Trace Parameter

Measurement parameters and analysis parameters display in the parameter window (Figure 7-18).

=T

Fange : 40.0 km
PulzeWidth : 300 ns
Wavelength : 1550 nm
IOR : 1. 46660
Scatter Cosf. : -52.1 dB
hverage Time 0o:00:15
End Threshold : 3. 000 dB
[MRefl. Threshold 0.200 dB
Fefl. Threshold =52.000 dB
Samp. Dist: 2.86 m

Figure 7-18. Parameters

Fiber Section Information

The distance between marker A and B should be considered as one section of optical fiber
(Figure 7-19).

= Marker Information | =o)X
a-F: 97063 m
2pt. Loss: 0.181 4B
2pt. Attn.: 0.186 dB/km
ILSA Attn. : 0.202 dB/km
Inz.Lozz at A: -.—— db
Fefl, at A: =q47.601 dB
2pt. OFL: 43.212 db
Cum.Loss to A 0.732 dB

Figure 7-19. Fiber Section Information

Fiber Chain Information

The distance from beginning to end should be considered as a fiber chain (Figure 7-20).

~ Total Fiber Information o =]
Eeasurs Date: 06/08/2012 13:44:27

Total Length: &.43391 kn

Total Loszs: 2,717 dB
Total Attn.: 0.422 dB/km
Total ORL: 27,833 dB

Evert HNumber: 3

Figure 7-20. Fiber Chain Information
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Review Events List

The trace curve decreases at a fixed slope. Any sudden peak or drop should be considered an
event. The 930XC acquires measured data automatically and creates the events list (Figure 7-21).

=l

Ewent Table

LW Prov [06) | Comvnuet |
1 |k sar: 0l DIJEIIJD 46 JIJU' 25 2935&
2 =~ Hp.. 13.06963

3 4 e -—

12.22...
25.29...

-23.907

‘1 827
0,00

12 22369
1306969

Figure 7-21. Review Events List

For details relating to the events list, refer to “Events List Window” in this section.

Save Trace

Opened trace files can be saved in the same manner as other files. Click “save trace file” under the
“File” menu to save a trace with an existing file name. Click “save as trace file” under the “File”
menu to save a trace with a new file name.

ASCII Format Output

Trace Viewer software provides a software interface so that data can be exported in ASCII format
and then opened and viewed by a third-party application like MS Excel.

Select “ASCII format output” under the “File” menu (Figure 7-22). Select the information and
format, and then press Enter to choose the path and file name.

x|
~ Separator
[v Trace Info ® Space
[V Neas.
eas, Info € Comma
[v Event Table
[+ Trace Data " TAB

L« | [

Figure 7-22. ASCII Format

Edit Optical Fiber Information

Select “Edit information of optical fiber” under the “Edit” menu, or click & to start editing
optical fiber information (Figure 7-23). Information of optical fiber is a description of
measurement trace displayed in the trace window. Users input relevant information for efficient
management of measurement files. Upon completion of editing, press Enter to confirm.

Trace Informeation L 1‘

[ Labels
Cable ID |
Fiber ID |
Fiber Type ICom'tntic-nal Singlemods Fiber
Orig. Location |
Tern. Location |
Operator |
Device |

Comments

Of I
Figure 7-23. Edit Optical Fiber Information

Cancel |
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Revise Events List

Because field measurement situations are constantly changing, the 930XC analysis software
cannot guarantee that every analysis is correct. The software provides an interface for users to
revise the events list: add event, revise event, delete event, and delete events list.

Add Event

If an event on the measurement trace is not listed in the events list (due to inaccuracies caused

by poor SNR or inadequate parameter configuration), use the “add event” function to manually
add this event into the events list. Click the events list window, and select “Add event” under the
“Editing” menu (Figure 7-24). Choose the type of event from the pull-down menu, enter the event
features, and then press Enter to add the event to the events list.

x|

Event Type |HOI’|REf]. v|

Location IW kn
Reflectance I'f'lf'— dB
Attenuation IW db/kn
Inz. Loss Ir dE
Cum. Loss I(‘— dB

_omen |

Figure 7-24. Add Event

Revise Event

Use the “revise event” function to manually revise features of an event (due to inaccuracies caused
by poor SNR or inadequate parameter configuration). Select the event to be revised in the events
list window, and select “Revise event” (Figure 7-25). After modifying the event feature(s), press
Enter to confirm the changes. The software will automatically refresh the event sequence.

Events can also be revised by clicking on the event to access a pop-up menu.

%
Event Typs HonBefl. 'l

Location IW kn
Reflectance l'— B
Attenuation |-0. 21 db/ ke
Ins. Loss IODZ— dB
Cun. Loss I'—‘ dB

x|

Figure 7-25. Revise Event

Delete Event

Use the “delete event” function to manually delete a trace from the events list when it appears in
error (due to inaccuracies caused by poor SNR or inadequate parameter configuration). Highlight
the event to be deleted, and then select “Delete event” under the “Editing” menu.

Events can also be deleted by clicking on the event to access a pop-up menu.
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Printing
Printing Options

Select “Printing options...” under the “File” menu (Figure 7-26), to select the contents to be

printed.
x|
¥ Trace Infornatic ® Hermal
[ Trace ¢ Vizable Trace
[¥ Shew Grid
v Show Narlker ¢ Nulti Trace
[+ Fiber Info

[¥ Event Table
[¢ Narker Info

I~ Logo | _|
Cancel I

Figure 7-26. Printing Options

Printing Setup

Select “Printing setup” under the “File” menu (Figure 7-27) to select the printer, paper size, and
printing orientation.

x|

- Printer
MName: Solid PDF Toals Properties. .. |
Status:  Ready

Type: Solid PDF Tools
Where:  Solid POF Post:

Comment:

~ Paper i 1
Sz |ad [ @ Forrat
Source: |Man Paper Tray =] @ (" Landscape

Network.._| [ ok | Ccancel

Figure 7-27. Printing Setup
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Printing Preview

To preview the page before printing, select “Printing preview” under the “File” menu or click m
on the tool bar (Figure 7-28).

8 930XC OTDR Trace Viewer - [cusers\jia\desktop\25296.sor] - © HEM|

| [Hext Page | Prev Fage| Two Page |[ Zoom In |[ Zoom Out || Close |

OTDR Report
AE - 25256 z0r TestDate - 0122020 130642 Dee
Caoe D Ong Location
FoeriD Tem_Locaton -
Cpemtor Fber Type - Conventonal Shgemade Fier
Range - 400km Pulewim - 300ns Waveengn: 1550 nm
IOR - 146660 Scamer Coet. - 62.10 08 Average Tme © 00-0030
End Thesholl - 30008 NRefiTheshold - 02008 Refl Thesholl - $200 08

CEEEEITEY o< =35 - I o

Makes AE MakerA
AD 394052 km Foston 25 294km
20t Less: 1707 @ s Loss 31s2 244308
2pt Aterwatbn: 0.191 s8&m Refectance at#2: -8492008
LSA-ARenuation: 0.190 aBxm Cum Loss 0 A: 4757 aB
2pt ORL 33964 08 v —
Total Aber
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Figure 7-28. Printing Preview
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? TEMPO 930XC-20C « 930XC-20M « 930XC-30F « 930XC-30P

COMMUNICATIONS

Batch Edit

The 930XC Trace Viewer software has a batch-edit function that allows users to edit the trace
information of several trace files in the same folder at one time. Select “Batch Edit” under the
“File” menu (Figure 7-30).
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Figure 7-30. Batch Edit

Batch Print

The 930XC Trace Viewer software has a batch-print function that allows users to print several
trace files in the same folder at one time. Select “Batch Print” under the “File” menu (Figure 7-31).
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Figure 7-31. Batch Print
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? TEMPO 930XC-20C « 930XC-20M « 930XC-30F « 930XC-30P

COMMUNICATIONS

Batch Print Preview

To preview before batch printing, select “batch print preview” under the “File” menu
(Figure 7-32).
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Figure 7-32. Batch Print Preview
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COMMUNICATIONS

Exit Software

Press “Exit” under the “File” menu (Figure 7-33) to exit the Trace Viewer software.
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Figure 7-33. Exit Software
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